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CREATING FORM WITH FORM

WIZARD AND FORM DESIGNER

8.1 INTRODUCTION

Forms are very powerful tool embedded in almost all the Database

Management System. It provides the basic means for inputting data

for the application.  Almost every application has at least one form.

Some forms only display information to the users.  However, most

forms require some degree of user interaction.  Forms are part of

object-oriented programming whereby, users expect to be in control

of the application.

When you create a form either with form Wizard or by using Form

Designer, you are actually writing Visual FoxPro source code for

your application.  When you save a form with a file name, Visual

FoxPro stores the information about the form designs in a special

data file with the same name as of the form and an extension of

.SCX

8.2 OBJECTIVES

After going through this lesson, you would be able to

l create a Form with Form Wizard

l run a Form

l create One-to-Many Form Wizard
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l create a form using Form Designer

l use List Boxes

8.3 CREATING A FORM WITH FORM WIZARD

To create a form by using From Wizard, choose New option from File

menu or click the New tool box.  The New dialog box appears.  Select

the Form radio button and then click the Wizard push button.

Visual FoxPro displays the Wizard Selection dialog box as shown in

fig 8.1. This dialog box allows you to select one of the two form styles

available in Form Wizards.

Fig. 8.1: Selecting a Form Wizard

The first one, Form Wizard is a simple form based on a single table.

The second is a One-to-Many Form Wizard based on relational

databases i.e. using two or more related tables.  The description of

each style is given in the Description Box.

Select the Form Wizard to display the first page-step1 of the Form

Wizard dialog box as shown is figure 8.2.
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Fig. 8.2: First step of the Form Wizard Dialog box

8.3.1 Selecting the Table

Every form is based on a table.  The first dialog box of Form Wizard

allows you to select one or more tables on which your form is based

and select the fields of that table to be included in the form.

The Databases/Tables option available with the first step of form

Wizard dialog box, displays the current database, if it is open.

Otherwise, it display the words Free Tables as shown in figure 8.2.

If a database is open, the name of the tables it contains appears in

the scrollable list.  If the database is not open, or if you want to use

a free table, click the ellipsis button (…), which opens a dialog box

that allows you to select the required table.  The Open dialog box

displays all the existing tables and allows you to select the required

table.  Choose the table named “STUDENT”.

8.3.2 Selecting Fields

After you choose the required table, you need to select the fields of

the selected table to be included in the form.  The dialog box also
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includes Fields Picker buttons or movement buttons, which are found

between the Available Fields list and Selected Fields list.  The arrow

directions indicate the way they move fields.  A single arrow moves a

single field and the Double arrow buttons move all the fields.  To

more a field from the Available Fields list, first select the field, you

want to move by clicking it or by using the arrow keys and then click

the top buttons with night arrow.  This moves the highlighted field

to the Selected Fields list.  Repeat this process to move more fields

from Available Fields list to Selected Fields list as shown in

figure 8.3.

Fig. 8.3: Form Wizard Dialog box

If you want to move all the fields from the Available Fields list to

Selected Fields list, click the double right arrow.  If you have selected

the wrong fields or want to remove any field from the Selected Fields

list, then select the field from the Selected Fields list and click the

left arrow.  Similarly, you can choose the double-left arrow to move

all the fields from the Selected Fields list to Available Fields list.

Let us click the double right arrow, to move all the fields of

“STUDENT.DBF” from Available Fields list to Selected Fields list.

Remember that the order of the selected fields determines the order
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in which the Wizard places the fields on the form.  It also determines

the default tab order for the form.  However, you can customize your

form generated by the Wizard by using Form Design.

Choose Next push button to proceed further to the Step-2 of the

Form Wizard.

8.3.3 Selecting Style

The Step-2 Choose Form Style of Form Wizard allows you to define

the overall form style.  Visual FoxPro provides the five basic types of

style.

– Standard

– Chiseled

– Shadowed

– Boxed

– Embossed

In the upper-left corner of the dialog box, you can preview an

illustration of each Style as you select it as shown in figure 8.4.

Fig. 8.4: Step2 of the Form Wizard Dialog box
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The Styles box also includes four button type selections.  This option

refers to the buttons added automatically to the bottom of the form

for navigation and editing.  You can display these buttons with either

text or picture icons to identify them. You can also choose No buttons

radio button to not include buttons on the form.  You can also choose

the Custom radio button to customize your form in your own way,

once you are finished with the Form Wizard.

Let us choose Standard from the Style list and Text buttons radio

button from the Button type.  Choose Next push button to proceed

further to the Step3 of the Form Wizard.

The following controls buttons are added to Wizard generated form:

Button Description

Top Allows you to move to the first record.

Prev Allows you to move to the previous record.

Next Allows you to move to the next record.

Bottom Allows you to move to the last record.

Find Allows you to locate a record.

Print Allows you to print the records in the table.

Add Allows you to add a new record.

Edit Allows you to edit the current record.

Delete Allows you to delete the current record.

Save Allows you to save the changes to the current

record.

Revert Allows you to throw out changes to current

record and reread original field contents.

Exit Allows you to come out of the form.

8.3.4 Specifying Sort Order

The next step of the Form Wizard is the Step3-Sort Record of Form

Wizard.  It allows you to create a sort order for the records.  Since

the forms save the data environment, it can define a sorted view of

the selected table fields.  If you do not select a sort order, the form

displays the records from the table in their natural order in which

the record are added in the table.  You can select any field from the

Available Fields list and move it to the Selected Fields list by clicking

the Add > key.  You can select even more than one field for the
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sorting order.  However, the order in which you select these fields

determines their sort priority.  You can also change the sort priority

by moving the selected field using the double-headed buttons to

the left of the field names.  Just click a double-headed button and

drag it up or down to a new position.  If you have selected a wrong

field for the sorting order or if you want to remove any field from the

Selected Fields list to the Available Fields list, then select the field

you want to remove and then click the  <Remove push button.  Let

us select Enrol field from the Selected Fields list and move it to the

Selected Fields list for specifying the sorting order as shown in the

figure 8.4.

Fig. 8.5: Sort Records of Form Wizard Dialog box

You can also sort the data in ascending or descending order by

clicking the required radio button available in this Form Wizard

dialog box.  Choose Next push button to proceed further to the

Finish step of the Form Wizard.

8.3.5 Generating a Form

The last step of the Form Wizard is the Step4-Finish Form Wizard as
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shown in the figure 8.6.  Here you need to give the title of the form.

The text appears at the title bar and it displays the name of the

table as the default name of the form.  You can also have three

options:

l Save  the form for later use

l Save and run the form

l Save the form and modify it in the Form Designer.

Fig. 8.6: The Finish Step of the Form Wizard

The first option lets you save the form for later use and returns you

to wherever you were before you standardized the Form Wizard.

The second option saves the form and immediately runs it.  The

third and last option saves the form and immediately opens the

Form Designer with the new form allowing further customization.

You can also click the Preview push button from the Step 4 - Finish

of Form Wizard to create the form based on the definitions provided.

This is only to see the whether the form created is as per the

requirement or not.  The form is partially functional in this mode as

you can see from the dimmed buttons at the bottom in the fig. 8.7

(Note that PIN field contains a comma after 3 digits as its type has

changed to character). However, you can move through the records

in the table to verify the order.  But the other push buttons are not

available until you generate the form.
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Fig. 8.7: Previewing the Form

Click the Return to Wizard! Push button to return to the last step

of the Form Wizard.  You can do the required changes in the Form

at the appropriate step by using the Back push button.  You can

move between the steps and the preview mode as many times as

you wish to finalize the Form.

After you click Finish push button,  Visual FoxPro displays the Save

As dialog box to let you name the form.  Later you can make changes

in the form through Form Designer only.  Remember, you cannot

re-enter the Wizard for an existing form.  Let us save the form with

the name STUDENT.

8.4 RUNNING A FORM

Like a Query, Visual FoxPro Form is a program, and you can run it

the same way.  Choose Do option from the Program menu.  Do

dialog box appears to select the form or choose Run button from the

toolbar.  You can also run a form by simply typing the following in

the command window

Do Form Student
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Fig. 8.8 shows an ordinary control panel with text buttons of a form.

Fig. 8.8 : Visual FoxPro Form with Text Buttons on the Control panel

8.5 CREATING A ONE-TO-MANY FORM WIZARD

The One-to-Many Form Wizard is similar to the form Wizard that

was covered in the previous section of this lesson.  The primary

difference is that it creates forms using two tables.  More specifically

it creates a form to display individual parent records and all of their

children.  The parent record fields typically appear on the top half of

the form using individual text box fields.  The child records generally

appear in a scrollable browse like grid half of the form.

To create a One-to-Many Wizard, choose New option from File menu

or click the New tool box.  The New dialog box appears.  Select the

Form radio button and then click the Wizard push button.  Visual

FoxPro displays the Wizard Selection dialog box as shown in fig.

8.9.

Fig. 8.9:  Form Wizard Selection dialog box
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Choose the One-to-Many Form Wizard form Wizard Selection dialog

box.  The “Step 1- Select Parent Table Fields“ dialog box appears to

select the fields from the main or parent table. It is similar to the

first step of the regular form Wizard shown in fig. 8.10.

Fig. 8.10: Step1 Select Parent Table Fields

As with a normal Form Wizard, you start by selecting a database or

table to use as the main or parent table.  From the Available Fields

list, select fields which are to be included on this form.

For example, click the ellipsis (… ) button to the right of Database/

Table option and use the Open dialog box to choose “STUDENT” as

the main table.  Click the double-right arrow to select all the fields

from the Available fields list to Selected Fields list, as shown in Fig.

8.10.

Please note the small, red arrow pointing to the top half of the form

in the form image area in the upper left corner.  This visually reminds

you where the main data appears in the form.

Click the Next push button to go to “Step 2: Select Child Table

Fields” as shown in Fig. 8.11.
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Fig. 8.11: Step 2 Select Child Table Fields

The second step looks very much similar to the first step, except

that in this step prompts for the fields from the related or child table

is displayed in the Available Fields list.  Note that the red arrow in

form image has shifted down to the lower half of the screen.  All

child records appear in a browse like control. Therefore, all fields

must fit horizontally across the form.  If you select more fields than

those which can fit horizontally, the wizard adds a horizontal scroll

bar to view them.

Click again the ellipsis (….) button to the right of the Databases/

Table option and choose “RESULT” as the related or the child table,

click the double- right arrow to add all the fields from the Available

Fields list to Selected Fields list, as shown in Fig. 8.11.

Note that the most important fields when creating a one-to-Many

form are the fields that define the relation between the parent and

child. In this case, ENROL appears in both STUDENT and RESULT

tables.  Choose Next push button to proceed further to the Step 3 -

Relate Tables of the One-to-Many Form Wizard.
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The Wizard sets this relation between the Parent table and the Child

table in step 3 automatically when a persistent relation exists

between the two files in their database. Otherwise, you can easily

establish the relationship using the drop down field lists from both

the tables as shown in the Fig 8.12. The relation formed between

parent and child table is shown by the line joining the two Tables.

Fig. 8.12: Step 3 - Relate Tables of the One-to-Many Form Wizard

Click Next push button to go to “ Step 4- Choose from Style” and

select Standard as a style and Text radio button as control panel

button type.  The style options are the same as the Form Wizards

styles listed in the previous section and shown in figure 8.3.

Click Next push button to go “Step 5- Sort Records” and double

click on Enrol to use it as the basis of the sort order. This step is also

the same as the one we discussed in the Form Wizard and shown in

Fig. 8.5.  Click Next push button to go to the “Step 6- Finish” dialog

box. In this last step as in the case of Form Wizard, you need to give

the title of the Form. Enter “Data Entry Module” as the title of the

form. Select the “Save and Run Form” radio button and click Finish
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push button.  In the Save As dialog box, enter the name of the form

(STUDENT3.SCX), and click Save push button.  Visual FoxPro

generates the forms as shown in Fig. 8.13.

Fig. 8.13: Form Wizard with two tables

Now, try using your “Data Entry Module” form with all the available

features at the control panel and choose Exit push button, when

you have finished.  Remember that once you save the form and exit

the wizard, you cannot return to wizard to make changes.  You must

make all subsequent changes using the Form Designer, which we

are going to discuss in the next lesson.

INTEXT QUESTIONS

1. Write True or False for the following statements

(a) Forms provide the basic means for inputting data for the

application.

(b) Form wizard helps you to create a form step by step.

(c) There is only one type of form style available.

(d) You can have only text buttons in your form.
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e. Can you create a blank form i.e. without using the tables.

2. Fill in the blanks:

(a) The extension of a form file is given as ————————

(b) One-to-many form is created using ————— tables.

(c) In the last step of form wizard the ——————— of the

form is given.

3. Where do you require a Form?

8.6 CREATING A FORM USING FORM DESIGNER

The Form Wizard has its own limitations for developing a form.  These

limitations are done away with the help of Form Designer.  The

Form Designer is the powerful tool available with Visual FoxPro to

design your form as per your requirement. You also use Form

Designer after you create a Form using Form Wizard for all subsequent

changes you wish to do with the Form.

Visual FoxPro object oriented programs support Form as a Visual

object.  A Form is such an object in which you can place other

objects i.e. you can create new forms from existing one. With objects

inheritance you can create a basic form definition and then use it to

create all subsequent forms for an application.  For example, you

may wish to define the overall appearance, color, fonts, etc.  Then

simply save this as a visual class and use it as a template for all new

forms.

There are several ways to create a new form:

q Select New option from File menu.  Select Form radio button

and click the New File button.  A blank form occurs as shown

in figure 8.14. It shows the open Form Designer work area, in

which you can build a visual representation of the form.

q You can also create a Form by typing the command CREATE

FORM in the Command Window.

q You can also use the Form Wizard

q Enter the Command

Newform = (CREATEOBJECT(“FORM)

New Form.Open
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Fig. 8.14: Creating a Form with Form Designer

Similarly, there are several ways to modify an existing form:

q Select Open option from the File menu.  Open file box appear

on the screen.  Choose Form from the File Type and open the

form named STUDENT3.SCX or simply type the name of the

form in the Name of the File text box.  The form STUDENT3.SCX

is displayed in the Form Designer as shown in the Fig. 8.15.

q As discussed earlier, you can also modify a form you have

created using the Form Wizard.  Enter the following Command

in the Command Window and press Enter.

MODIFY FORM <Filename>
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Fig. 8.15 : Modifying an existing Form using Form Designer

You can add various objects into the Form to make it more interactive

or as per the requirement of the form using controls toolbar.

8.7 FORM PROPERTIES

Form properties are the features and attributes by which a form is

defined.  The basic visual appearance of a form is that of a window,

its use of properties makes it much more than a simple window.

Forms have over 60 properties.  When you create a form, all properties

have default values.  In order to make the form more and more

interactive, you need to specify the properties, which you want to

change.  When you specify or change the properties of a form, you

actually do the coding for the Visual FoxPro.  Fortunately, most of

the time, only a few properties need to be changed.  The most obvious

of these include:

q Size

q Position on-screen

q Title

q Foreground and background colours

Open the properties window to see the current settings.  Visual
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FoxPro divides object properties into four frames: Data, Methods,

Layout and Other.  Of course, you will find one more frame, All,

which includes all properties.

To change one, click it to select or highlight it with the arrow keys.

Visual FoxPro places the current value in the edit box at the top of

the page.  Fig. 8.16 highlights the Caption property and has already

changed the default value of Form1 to Data Entry Form.  You will

notice that the change is immediately reflected in the actual form’s

title bar.

Fig. 8.16:  The Form Designer with change Form Title

A few properties such as ForeColor and BackColor display a button

with three dots or an ellipsis.  This button indicates that another

dialog box exists with options for this property.  In this case, clicking

the button opens the Colour dialog box, which displays a grid of 48

pre-defined colours.  It also allows you to define, custom colours.
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8.7.1  Data Environment

Almost every form needs to refer data from one or more tables.  To

include the required tables in the definition of the form, choose

Data Environment option from the View menu.  This opens a window

titled Data Environment.  Here you can add the required table for

your Form.

8.7.2  Adding Controls to a Form

After defining the data environment, the next step is to add controls

to the form.  Visual FoxPro supports several types of controls.  You

can add controls to a form using Form Controls Toolbar.  Here you

add all the fields of the table required for your form.

Label Controls: Labels are simple text strings added to a form

to identify fields or to display fixed character

information to the user.  A label can be a

single line or it can span several lines.  The

most common label properties include the

capability to change font, size and style.  You

can also define a background colour to a label.

A simple box border can also surround the

text of your label.  Labels do not have a data

source.  You enter the text directly into its

caption property.  Remember, when the

program is running, the user cannot edit or

tab into a label.

Text Box Controls: The primary difference between a label and

text box is their respective data source.  For

a label, the text is fixed as the Caption

property for the object.  On the other hand,

the source for a text box is usually a table

field, but it could also be a memory variable.

The most common properties modified for a

text box include those related to colour, font,

size, position of the text box and the data

source.

8.7.3 Specifying the Tab Order

To move from one field to the next by using mouse, is not always the

most convenient way to do so.  User can press Enter or Tab, once

they are through with the current field and are ready to move to the

next.
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By default Visual FoxPro defines the tab order by the way you add

the fields to the form.  However, you may add fields later that did

not exist in the original form, then by the default order the cursor

will move to such field only at last.  You can change the tab sequence

by using the Tab Ordering pull-down list.

8.7.4 Using List Boxes

A list box is a control box that allows you to create a scrollable list

from which the user can make a selection.  The List Box control on

the Forms Control toolbar allows you to create a list box on your

form.

8.7.5 Using Combo Boxes

A combo box allows you to enter a value or select an item from a list.

It is a combination of a text box and a list box.  The Combo Box

control on the Forms Control toolbar allows you to create a combo

box on your form.

8.8 WHAT YOU HAVE LEARNT

In this lesson you have learned about the Form Wizard, which

supports two form styles.  The first is the simple form based on a

single table.  The second creates a on-to-many form.  You have also

seen the limitations of the Form Wizard and to break beyond those

limits, you should use the Form Designer.

In the Form Designer, you have learned about the basics of creating

a form and the usage of advanced form design controls such as

labels, text boxes, list boxes and combo boxes  to create more user-

friendly applications.

8.9  TERMINAL QUESTIONS

1. Explain the different steps involved in creating a form using

form wizard.

2. What do you understand by parent table and child table and

when are they used?

3. Write steps for creating a form-based on a table.

4. Write command for running a form from command window.

5. Write steps for creating a control button ‘Revert’ to the existing

form as in Fig. 8.7.

6. What is the difference between creating a form through Form

Designer and Form Wizard?
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8.10 KEY TO INTEXT QUESTIONS

1. (a)   T  (b)  T   (c)  F  (d) F  (e) T

2. (a)  .scx

(b)  two

(c)  title

3. A Form is used to present the data/information on screen/

paper from the stored huge database/tables. It can also contain

text without data from Tables.


